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Условные обозначения 4

Условные обозначения

WinEdt — советы по работе в редакторе WinEdt (см. c. 4).

7.1. Команда \includegraphics и bmp-файлы— гипертекстовая ссыл-
ка на раздел учебника.

[2] — гипертекстовая ссылка на библиографический источник.

— обозначение начала примера (см. пример на c. 13).

— обозначение начала упражнения (см. упражнение на c. 18).

Исходный код: (например, см. c. 14)

TEX-код

\documentclass{article}

\begin{document}

\end{document}

— замечание (например, см. замечание на c. 13).

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть III 4
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План занятий

Модуль I

1. Знакомство с LATEX 2ε

Лекции (2 ч.) + практика (1 ч.)

1. ПО для работы с TEX’ом: классификация, установка, настройка.

2. Классы документа. Использование дополнительных пакетов.

3. Классы документа. Использование дополнительных пакетов.

4. Основные понятия TEX’а.

5. TEX’овские единицы длины.

6. Титульная страница: определение, основные составляющие, созда-
ния титула в TEX’е с помощью специальных команд.

2. Макет полосы набора; проекты

Лекции (1 ч.) + практика (2 ч.) + индивидуальный проект (1 ч.)

1. Макет полосы набора: параметры страницы, стиль оформления
страниц, интерлиньяж, абзацный отступ.

2. Создание TEX-проектов.

3. Набор текста

Лекции (1 ч.) + практика (2 ч.)

1. Атрибуты шрифтов. Буквальное воспроизведение.

2. Кавычки, многоточие, тире и дефисы.

3. Вертикальные и горизонтальные пробелы: тонкая настройка.

4. Верстка текста, автоматическая генерация ссылок

Лекции (2 ч.) + практика (2 ч.) + индивидуальный проект (2 ч.)

1. Разрывы страниц. Создание пустых страниц.

2. Структура текстового документа.

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть III 5
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3. Титульная страница: создание оригинальной титульной страницы.

4. Создание аннотаций.

5. Команды секционирования. Правила оформления заголовков.

6. Оглавление. Организация автоматических ссылок на разделы доку-
мента.

7. Создание списков литературы. Организация автоматических ссы-
лок на литературные источники.

8. Абзацы с нестандартным форматированием.

9. Создание таблиц.

10. Создание и использование шаблонов текстовых документов.

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть III 6
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Модуль II

5. Набор простых формул

Лекции (2 ч.) + практика (2 ч.)

1. Правила набора формул (внутритекстовые и выключные формулы,
знаки препинания в формулах).

2. Математические шрифты.

3. Размер символов в формулах.

4. Разные символы и знаки, греческие буквы.

5. Символы бинарных операций и отношений, стрелки, степени и ин-
дексы, дроби, корни, штрихи.

6. Набор формул — почти “высший пилотаж”

Лекции (2 ч.) + практика (2 ч.)

1. Скобки и ограничители, команды \left и \right.

2. Названия операций, операции с пределами.

3. Создание собственных операций.

4. Пробелы в формулах.

5. Текст в формулах.

6. Надстрочные знаки.

7. Нумеруемые однострочные формулы.

8. Многострочные формулы — окружение array.

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть III 7
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Модуль III

7. Вставка изображений

Лекции (1 ч.) + практика (2 ч.)

1. Универсальная команда \includegraphics.

2. Масштабирование и поворот рисунка.

3. Окружение figure.

4. Создание списка иллюстраций.

5. Создание министраниц.

8. Программа TpX

Лекции (1 ч.) + практика (2 ч.)

1. Специализированное графическое ПО для создания рисунков для
TEX’а.

2. Специфика создания рисунков для публикации.

3. Работа с векторным редактором TpX.

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть III 8
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Модуль IV

9. Цвет и визуальные эффекты

Лекции (2 ч.) + практика (2 ч.)

1. Цветовые модели RGB, CMYK, grayscale. Первичные и вторичные
цвета. Цветовой куб.

2. Цвет фона страницы и цвет текста.

3. Цветные боксы.

4. Рамки с тенью.

5. Списки в рамке.

10. Электронные документы в формате PDF

Лекции (2 ч.) + практика (2 ч.) + индивидуальный проект (2 ч.)

1. Пакет hyperref.

2. Принципы создания электронных учебников, пособий и т. п.

11. Создание презентаций

Лекции (2 ч.) + практика (2 ч.) + индивидуальный проект (2 ч.)

1. Класс beamer.

2. Основы создания электронных презентаций.

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть III 9
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7 Вставка изображений

Тип используемого графического файла зависит от формата резуль-
тирующего файла (dvi или pdf). Для создания dvi-файла подойдут bmp-
и eps-файлы. pdfLATEX — вариант системы LATEX, напрямую создающий
pdf-файлы, — поддерживает файлы форматов jpeg и pdf.

1. Лучше всегда создавать одноименные файлы двух форматов — eps

и pdf, и не заботиться об используемом способе трансляции tex-файла.
Форматы Portable Document Format (PDF) и Encapsulated PostScript
(EPS) позволят получить наиболее качественные изображения.

Для включения графического файла в исходный документ предназна-
чена команда \includegraphics, определенная в пакете graphicx

\includegraphics[параметры]{имя графического файла}

В имени графического файла можно (иногда даже нужно) не указывать
расширение файла.



Вставка изображений 11

Как правило, команда \includegraphics используется в отдельной
строке, однако она может использоваться и внутри текста для вставки
небольших изображений .

Если графический и исходный файлы находятся в разных каталогах,
то имя файла в \includegraphics должно содержать и имя каталога:

имя графического файла = имя каталога/имя файла

Исходный TEX-код

\includegraphics[height=5cm]{pictureslab/Hamster}\qquad

\includegraphics[height=5cm]{pictureslab/CatInBox}

Рис. 1. Вставка jpg-файлов

7.1 Команда \includegraphics и bmp-файлы

При использовании bmp-файлов в преамбуле документа необходимо
указать декларацию:

\DeclareGraphicsRule{.bmp}{bmp}{}{}

Шаблон команды для подключения bmp-файлов имеет вид

\includegraphics[width=ширина,height=высота]{имя файла.bmp}

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть III 11
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Указание параметров ширина и высота, а также расширения файла при
подключении bmp-файлов обязательно! Например,

Команда для включения bmp-файла

\includegraphics[width=254pt,height=100pt]{Dog_02.bmp}

Рис. 2. Вставка bmp-файла требует аккуратного указания размеров изображения

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть III 12
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7.2 Команда \includegraphics и файлы форматов EPS и PDF

Простейшая команда для подключения eps-файлов (и pdf-файлов) име-
ет вид (расширение файла лучше не указывать)

\includegraphics{имя файла}

7.3 Размер рисунка

Параметр scale (только для файлов EPS и PDF) используется для
масштабирования изображения

scale = масштаб

масштаб — любое вещественное число, например, значение scale=1.1

увеличит рисунок на 10%.

7.1. Параметр scale позволяет легко создать такую «матрешку».
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Исходный TEX-код

\includegraphics[scale=1]{R1}\quad

\includegraphics[scale=0.5]{R1}\quad

\includegraphics[scale=0.25]{R1}

2. Значение параметра scale необходимо выбирать таким образом,
чтобы символы, входящие в рисунок, были соразмерны символам, ис-
пользуемым в основном тексте.

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть III 13
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Рисунокфиксированного размера получается заданием параметров width
и height:

width = ширина, height = высота

ширина и высота рисунка указываются в TEX’овских единицах длины,
при этом можно указывать либо ширину, либо высоту. Значение неука-
занного параметра вычислится автоматически.

7.2. На рис. 3 использованы четыре способа задания размеров изоб-
ражения: один раз явно указан полный размер рисунка (произвольно);
для второго/третьего рисунков указана только высота/ширина (произ-
вольно); четвертый рисунок выведен в масштабе 1:1.

Рис. 3. Способы управления размером рисунка

Рисунки включены с помощью четырех команд \includegraphics:

TEX-код

\includegraphics[width=104pt, height=90pt]{Fig_01}\

\includegraphics[height=90pt]{Fig_01}\

\includegraphics[width=104pt]{Fig_01}\

\includegraphics[scale=1]{Fig_01}

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть III 14
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7.4 Поворот рисунка

Параметр angle позволяет задать величину угла поворота рисунка

angle = угол в градусах

Направление вращения — против часовой стрелки. Ось вращения по
умолчанию проходит через точку отсчёта бокса — левый нижний угол.

angle = – −30 −60 −90 – 30 60 90

7.5 Окружение figure

Окружение figure позволяет задавать подпись к рисунку и снабжать
его меткой (см. рис. 4):

\begin{figure}[H]

\centering \includegraphics{имя файла}

\caption{Подпись к рисунку}\label{метка}

\end{figure}

WinEdt Команда меню: Insert → Objects → Figure

Параметр H в строке \begin{figure}[H] (корректно работает при
подключении пакета float) фиксирует положение рисунка в выходном
файле.

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть III 15
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7.3. Использование окружения figure:
Исходный TEX-код

\begin{figure}[H]

\centering \includegraphics{bear}

\caption{Мишка} \label{bear}

\end{figure}

Рис. 4. Мишка

3. Параметр \captionlabeldelim (пакет caption2) управляет видом
знака, стоящего после номера рисунка (по умолчанию это двоеточие):

\renewcommand{\captionlabeldelim}{.}

7.6 Создание списка иллюстраций

Информация об иллюстрациях, полученных с помощью окружения figure,
может собираться в файлы с расширением .lof и выдаваться в выходной
файл командой

\listoffigures

В результате выполнения команды \listoffigures в выходном файле
создаётся раздел «Список иллюстраций» (см. стр. 41).

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть III 16
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7.7 Министраницы и рисунки

При вёрстке текстовых документов c рисунками часто используется
окружение для создания министраниц minipage.

WinEdt Команда меню: Insert → Environments → Minipage

На рис. 5 схематично изображено
начальное распределение примеси и
величина ζ-потенциала на разных
участках границы, а также направ-
ление электроосмотического течения
вдоль изолированных границ.

0 j

k

64

32

(15,2) (17,2)

(17,31)(15,31)

ζ =10 ζ =10

ζ =−10ζ =−10

Рис. 5. Положение примеси

В предложенном примере использовано два окружения minipage:
TEX-код (шаблон)

\noindent
\begin{minipage}{80mm}
\parindent=7mm

На рис.\,\ref{Ris:MP} схематично изображено
начальное распределение примеси и величина ...

\end{minipage}\hfill
\begin{minipage}{65mm}

\begin{figure}[H]
\centering \includegraphics{RisZeta} \\
\caption{Положение примеси}\label{Ris:MP}

\end{figure}
\end{minipage}

В пакете boxedminipage определено одноимённое окружение для созда-
ния министраниц, окаймлённых рамкой. Расстояние между рамкой
и текстом определяется параметром \fboxsep (= 3 pt по умолчанию);
ширина линий рамки — \fboxrule (= 0.4 pt по умолчанию).

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть III 17
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7.8 Упражнения

7.1. Сделайте снимок (ScreenShot) окна любого приложения (напри-
мер, калькулятора Windows).

Простейший способ получения снимка экрана для операционной си-
стемы Microsoft Windows: использование клавиши <PrtScr> (для всего
экрана) или сочетания клавиш <Alt> + <PrtScr> (для текущего окна) на
клавиатуре. Снимок копируется в буфер обмена операционной системы
и затем может быть вставлен в графический редактор.

Изображение из буфера обмена поместите в графический редактор
Paint. Сохраните файл как BitMap (*.bmp).

Вставьте полученное изображение в TEX-файл, сохраняя его исход-
ный размер.

7.2. Возьмите любой bmp-файл и создайте последовательность рисун-
ков, масштабируя изображение, так чтобы отношения ширины к высоте
сохранялись (см. также пример 7.1).

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть III 18
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7.3. Возьмите любой eps-файл и создайте последовательность ри-
сунков по образцу:

7.4. Создайте трехколоночный текст в виде (рисунок любой, рамки
нужны):

Литературное
Программирование —
концепция,
методология
программирования
и документирования.

Рис. 6. Логотип

Термин и саму
концепцию разработал

Дональд Кнут
в 1981 году при создании
системы компьютерной

вёрстки TEX.

7.5. Разместите два рисунка из eps-файлов рядом:

Рис. 7. Букет-1 Рис. 8. Букет-2

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть III 19



Вставка изображений 20

7.9 Тесты

Раздел А «Выбор правильного ответа»

A1. Выберите верный вариант использования команды \includegraphics

для вставки изображения из bmp-файла:

а) \includegraphics{ИмяФ.bmp}

б) \includegraphics[scale=масштаб]{ИмяФ.bmp}

в) \includegraphics[width=ширина]{ИмяФ.bmp}

г) \includegraphics[height=высота]{ИмяФ.bmp}

д) \includegraphics[width=ширина,height=высота]{ИмяФ.bmp}

A2. При использовании команды \includegraphics{ИмяФайла} в имени
файла нельзя опускать расширение для файлов формата

а) bmp б) eps в) jpg г) pdf

A3. Выберите верный вариант использования команды \includegraphics

для вставки изображений из eps-файлов:

а) \includegraphics[width=100,height=200]{ИмяФ_1},

\includegraphics[scale=1pt]{ИмяФ_2}

б) \includegraphics[width=100pt,height=200pt]{ИмяФ_1},

\includegraphics[scale=1]{ИмяФ_2}

в) \includegraphics[width=100,height=200]{ИмяФ_1},

\includegraphics[scale=1]{ИмяФ_2}

г) \includegraphics[width=100pt,height=200pt]{ИмяФ_1},

\includegraphics[scale=1pt]{ИмяФ_2}

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть III 20



Вставка изображений 21

A4. Окружение figure позволяет

а) задавать подпись к рисунку и снабжать его меткой

б) всегда размещать рисунок в фиксированном месте

в) задавать размеры рисунка

г) создавать список иллюстраций

A5. Окружение minipage имеет обязательный аргумент для указания

а) положения министраницы на странице

б) положения министраницы в тексте документа в целом

в) ширины министраницы

г) высоты министраницы

A6. Для текста, попадающего в окружение minipage, необходимо вновь
указать параметр для установки

а) размера шрифта б) стиля шрифта

в) абзацного отступа г) кодировки

A7. Для создания списка иллюстраций служит команда

а) \figure б) \listoffigures

в) \graphics г) \listofgraphics

A8. Команда для создания списка иллюстраций всегда создает список
иллюстраций

а) в начале документа

б) в конце документа до списка литературы

в) в конце документа после списка литературы

г) в фиксированном месте документа (там, где указывается специ-
альная команда)

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть III 21
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A9. Для размещения рисунков в виде

Рис. 9. Визуализация результатов численного эксперимента

требуется набор команд
а)

\includegraphics[height=25mm]{Файл1}\quad

\includegraphics[height=25mm]{Файл2} \\

\caption{Текст заголовка}

б)
\begin{figure}[H]

\includegraphics[height=25mm]{Файл1}\quad

\includegraphics[height=25mm]{Файл2} \\

\caption{Текст заголовка}

\end{figure}

в)
\begin{figure}[H]

\includegraphics[height=25mm]{Файл1}

\end{figure}\qquad

\begin{figure}[H]

\includegraphics[height=25mm]{Файл2} \\

\caption{Текст заголовка}

\end{figure}
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г)
\begin{minipage}{ширина}

\begin{figure}[H]

\includegraphics[height=25mm]{Файл1}

\end{figure}

\end{minipage}\qquad

\begin{minipage}{ширина}

\begin{figure}[H]

\includegraphics[height=25mm]{Файл2} \\

\end{figure}

\caption{Текст заголовка}

\end{minipage}

A10. Для размещения рисунков в виде

Рис. 10. Горы Рис. 11. Берег

требуется набор окружений
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а)
\begin{center}

\begin{figure}

\begin{minipage}{ширина}

...

\end{minipage}

\qquad

\begin{minipage}{ширина}

...

\end{minipage}

\end{figure}

\end{center}

б)
\begin{center}

\begin{minipage}{ширина}

\begin{figure}

...

\end{figure}

\qquad

\begin{figure}

...

\end{figure}

\end{minipage}

\end{center}

в)
\begin{center}

\begin{figure}

\begin{minipage}{ширина}

...

\end{minipage}

\end{figure}

\qquad

\begin{figure}

\begin{minipage}{ширина}

...

\end{minipage}

\end{figure}

\end{center}

г)
\begin{center}

\begin{minipage}{ширина}

\begin{figure}

...

\end{figure}

\end{minipage}

\qquad

\begin{minipage}{ширина}

\begin{figure}

...

\end{figure}

\end{minipage}

\end{center}
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8 Программа TpX
8.1 Создание и редактирование рисунка
8.2 Добавление в рисунок текста
8.3 TpX и сохранение файлов
8.5 Упражнения

8 Программа TpX

Векторный редактор TpX позволяет создавать изображения, которые
можно экспортировать во многие форматы: EPS, PDF, BMP, EMF,. . . ,
причем прямо из редактора можно посмотреть результат построения
изображения в форматах DVI, EPS и PDF. Для создания файлов ука-
занных форматов программа TpX использует «схемы»:

LaTeX → DVI;

LaTeX → DVI → PS;

PdfLaTeX → PDF,

т. е. на компьютере должен быть установлен TEX.

Eout

u > 0

u < 0y
x

0.05

r

rotz u
0,4

0.1 0.15 0.2 0.25
0.25

0.35

0.45

0.55

0

1

2

3

0

123

4

Рис. 12. Примеры изображений, построенных с помощью программы TpX
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8.1 Создание и редактирование рисунка

Создать изображение «с нуля» можно с помощью команды меню New
из раздела File. Открыть файл для редактирования: File → Open.

Поддерживаемые типы файлов (для чтения и редактирования):

TpX (.tpx),
Windows Metafiles (.emf, .wmf),
Scalable Vector Graphics (.svg),
All Postscripts (.eps, .ps),
Portable Document Format (.pdf).

Обмен данными и графикой с другими Windows-приложениями мо-
жет выполняться также через буфер обмена.

Каждый объект в редакторе — линия, окружность, кривая и т. п. об-
ладает набором свойств, таких как толщина, вид и цвет линий. Доступ
к свойствам каждого объекта рисунка — двойной щелчок мышью по вы-
деленному объекту. В рисунок могут быть добавлены надписи, в том
числе и с использованием TEX-кода (см. п. 8.2).

Любой объект может быть преобразован (масштабирован, повёрнут,
отражен,. . . ) с помощью команд раздела меню Transform, а также кон-
вертирован в объект другого типа с помощью команды меню:

Edit → Convert to. . .

8.1. Вставим объект Graphical symbol (пиктограмма ). В каче-
стве графического символа выберем звезду (рис. 13, левое изображение).
С помощью команды меню Edit → Convert to. . . преобразуем объект
Graphical symbol в Closed Bezier path (следующее изображение).

Bézier curve (кривая Безье) строится с использованием минимум че-
тырёх точек: двух базовых (начало и конец кривой, обозначены квад-
ратиками) и двух промежуточных (управляющие метки-манипуляторы,
обозначены кружочками). Управляющие метки-манипуляторы позволя-
ют менять сложность и форму кривой.
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Рис. 13. Конвертирование и редактирование объекта

Изменяя положения базовых и промежуточных точек «строгую» звез-
ду преобразуем в «морскую» (рис. 13, правое изображение).

Полученную звезду скопируем два раза и изменим у каждой новой
звезды размер (Transform→ Scale→. . . ). Зальем каждую звёздочку сво-
им цветом (левое изображение на рис. 14). Команды

Transform → Flip horizontally и Transform → Rotate →. . .

позволяют получить зеркальное отображение (рис. 14, в центре) и про-
извольный поворот (рис. 14, справа).

Рис. 14. Преобразование объекта
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8.2 Добавление в рисунок текста

Для добавления в рисунок любых надписей служит кнопка<Ab> в ре-
дакторе TpX.

Вставляемый текст может иметь TEX-формат, причем в рабочем окне
TpX достаточно обозначить местоположение надписи и сделать «черно-
вик текста» (например, f(x+t)), а потом при помощи поля TeX Text
в окне «Text» (рис. 15) внести текст в формате TEX’а (в знаках $ для
формул) — $\varphi(x+\tau)$.

Рис. 15. Окно «Text» редактора TpX

На рис. 16 слева показан вид формулы в редакторе и справа — резуль-
тат в выходном файле (.dvi, .pdf, .ps).

ϕ(x+ τ)

Рис. 16. Одно и то же изображение в редакторе и в выходном файле
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8.3 TpX и сохранение файлов

Файлы, сохраняемые программой TpX, можно условно разделить на
две группы:

Файл с расширением tpx — исходный файл, содержащий информа-
цию для построения рисунка. Предназначен для редактирования
с помощью редактора TpX или текстового редактора.

Файлы с расширениями bmp, eps, pdf,. . . — выходные файлы для
включения в текстовые документы.

Для TEX-документов наиболее востребованными являются eps-фай-
лы, сохраненные как «LaTeX EPS», и для электронных документов —
pdf-файлы, сохраненные как «LaTeX PDF».

4. При работе с программой TpX сохранение tpx- и eps-файлов сле-
дует производить в разные каталоги или давать файлам разные имена.
Например,

Имя каталога Назначение каталога

Tpx для хранения tpx-файлов
Eps для хранения eps-файлов

Файлы eps и pdf являются временными для редактора TpX, они по-
являются даже при простом сохранении в том же каталоге, где хранится
tpx-файл, и с тем же именем. Временные файлы не содержат всей ин-
формации, которая должна находиться в выходном eps- или pdf-файле,
поэтому они получаются «испорченными».

Рис. 17. Изображения в tpx-файле и временном eps-файле различны
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Для получения полноценных финальных рисунков с формулами ис-
пользуйте разные каталоги для tpx- и выходных файлов и следующие
схемы сохранения:

для получения eps-файлов — LaTeX EPS (latex-dvips)

для получения pdf-файлов — LaTeX PDF (latex-dvips-gs-pdf)

8.4 TpX и проблемы

При возникновении проблем с трансляцией tpx-файла или сохране-
нии eps-файлов по схеме LaTeX EPS (latex-dvips) или pdf-файлов по
схеме LaTeX PDF (latex-dvips-gs-pdf) измените следующие настрой-
ки программы TpX в окне TpX Settings (см. рис. 18):

File → TpX Settings (для версии 1.4)

Рис. 18. Окно настроек программы TpX
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Для изменения настроек необходимо выбрать соответствующий пункт
и в окне ввода списка (вверху окна TpX Settings) и либо указать значе-
ние напрямую, либо выбрать нужный каталог, нажав на изображение
стрелки H.

Измените следующие значения

Поле Описание

PdfLatexPath путь к файлу pdflatex.exe

Например, 1) C:\Program Files\MiKTeX 2.9\miktex\bin\pdflatex.exe
2) C:\texmf\miktex\bin\pdflatex.exe

GhostscriptPath путь к файлу gswin32c.exe

Например, C:\Program Files\gs\gs8.64\bin\gswin32c.exe
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8.5 Упражнения

8.1. Создайте с помощью программы TpX рисунки и сохраните их
в форматах «LaTeX EPS» и «LaTeX PDF».

Ek =
mv2

2
Ek =

mv2

2

?

8.2. Используя инструменты Polygon (для рисунка 1) и Graphical
symbol (для рисунка 2), преобразуйте простые рисунки. Результат со-
храните в формате «Windows bitmap (BMP)».

Указание: см. пример 8.1.

1) 2)
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8.3. Создайте рисунки и сохраните их в формате «LaTeX EPS».

а)
A B

Γ∆

б)

Y

0 x1

2

Xy
B1

M
A1

A2

B2

8.4. Создайте рисунки и сохраните их в формате «LaTeX EPS».

а)
x1 2 3 40

1

2

3

4

y

A

B

F

C

E

D

y=4/x
y=x/4

y=1/x

y=4x

б)

x

y

0 a b

y=f1(x)

y=f2(x)

A

A1

B

B1

в)

x

y

0 a b

y=f1(x)

y=f2(x)

A

A1

B

B1
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8.5. Включите в tex-документ рисунки, полученные в задании 8.4.
Схема размещения рисунков (окружение minipage не используйте):

Рисунок 1 Рисунок 2

Рисунки возьмите в рамки.
Указание: не указывайте расширения для файлов изображений.

8.6. Создайте текст, соблюдая предложенный вариант размещения
рисунка и подписи к нему (используйте окружение minipage).

Найдем уравнение плоскости, от-
секающей на координатных осях от-
резки, величины которых равны a,
b, c (рис. 19).

Очевидно, что точками пересече-
ния плоскости с координатными ося-
ми будут точки

A(a, 0, 0), B(0, b, 0), C(0, 0, c).

z

x

y

A(a, 0, 0)

B(0, b, 0)

C(0, 0, c)

0

Рис. 19. Плоскость

На рис. 20 изображена иссле-
дуемая область. Твердые стенки
контейнера обозначены штрихом.
ζ-потенциал на левой и правой
стенках равен −160 и 160, соот-
ветственно. 0

1

2

A

B C

D

−160 160

x

z

Рис. 20. Область, границы
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8.7. Выполните задания:

1) Измените два черно-белых рисунка со штриховкой области из упраж-
нений 8.4 и 8.5 на цветные (пример оформления см. на рис. 21).

2) Сохраните результат в формате «LaTeX PDF», имена файлов долж-
ны совпадать с аналогичными черно-белыми eps-файлами.

x1 2 3 40

1

2

3

4

y

A

B

F

C

E

D

y=4/x
y=x/4

y=1/x

y=4x

Рис. 21. Пример цветного рисунка

8.8. Предложите свой вариант задания по темам «Рисование в редак-
торе TpX» и «Включение рисунков в TEX-документы». Задание оформи-
те в виде отдельного tex-файла и рисунков форматов eps и tpx.

Рис. 22. Рисунки, созданные в TpX. Авторы: Е. Рыбалкина и Н. Хасматулина (2013)
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dr
op

s
dr

op
s

Рис. 23. Рисунки, созданные в TpX

Рис. 24. Пример нестандартного размещения изображений
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Проектные задания
Задание № 1
Задание № 2

Проектные задания

Задание № 1. Создать минимальный файл LATEX 2ε для вывода тек-
ста, приведенного на стр. 38.

Задание № 2. С помощью редактора TpX нарисовать рисунки, при-
веденные на стр. 39. Форматы выходных файлов: pdf и eps.
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Задание № 1

Фотоконкурс «Мир глазами студента мехмата» (весна 2013)
(http://mmcs.sfedu.ru/component/phocagallery/category/137)

Рис. 25. Ростовская набережная ранней весной (М. Хасматулина)

Рис. 26. Море спокойствия (Г. Лукьянов)
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Задание № 2

0 x

y

u

v

0

δ
z0

E

E

x

y
O

x

y

y = 4x− x2

0 4 5

x

y

0 a b

A

B

C

D

y=g(x)

y = f(x)
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